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2 GNU noticeiDMC the interactive Dynamical Model Calculator simulates and performs graphicaland numerical analysis of systems of di®erential and di®erence equations.Copyright (C) 2004 Marji Lines and Alfredo MedioThe source code was written and designed by Daniele Pizzoni in collaboration withAlexei Grigoriev.The software program was developed within a research project ¯nanced by the ItalianMinistry of Universities, the Universities of Udine and Ca' Foscari of Venice, theFriuli-Venezia Giulia Region.This program is free software; you can redistribute it and/or modify it under the termsof the GNU General Public License as published by the Free Software Foundation;either version 2 of the License, or any later version.This program is distributed in the hope that it will be useful, but WITHOUT ANYWARRANTY; without even the implied warranty of MERCHANTABILITY or FIT-NESS FOR A PARTICULAR PURPOSE. See the GNU General Public License formore details. contents1. Main menu page 32. User input for algorithms 53. Absorbing area 64. Basin of attraction 75. Bifurcation 86. Cycles 107. Lyapunov exponents 108. Manifolds 119. Shifted and Cobweb 1110. Trajectory 1211. Model references 1312. New models 16



31. Main menuFilea. New model Clicking on this button brings up the directory models from whichone is chosen to be opened.b. Close model Clicking on this button closes the current model and all relatedplots.c. New plot This is the heart of the program. Clicking on this button brings upthe menu for plot types, that is, the menu from which the user chooses the routine tobe applied to the opened model. The options available for the class of model selected(basically, whether time is continuous or discrete and how many dimensions there areto the model system) will be highlighted as you drag the mouse over the plot name.See Sections 3-9 for detailed descriptions of speci¯c routines.d. Close plot Clicking on this button closes the current plot.e. Save image as This button allows the user to save a plot to a ¯le. Clickingon this button from a plot produced by one of the routines brings up the window inwhich the directory and ¯le name are chosen. Plots are saved as .png ¯les.f. Quit Clicking on this button closes the current window.g. Exit Clicking on this button closes the session and exits the program.CommandThe composition of the Command menu varies with the routine.a. Start Clicking on this button resets ranges and starts the algorithm.b. Stop Clicking on this button stops any calculation. This is particularly useful ifa long calculation has been con¯gured incorrectly.c. Clear Clicking on this button clears the current plot.d. Redraw Clicking on this button allows the user to redraw the same plot withnewly de¯ned ranges.e. Reset Clicking on this button releases the start button or menu.



4PlotThe composition of the Plot menu varies greatly with the algorithm and the detailsare given in the next section under the routine type.OptionsThis menu permits the user to change certain plot characteristics from the default.The Big dots and Connect dots options are available only for some discrete-timeroutines.a. Size Clicking on this button opens a menu giving the following choices500£500600£600Fit to windowCustom size This button opens a window in which the plot dimensions are ¯xed.b. Show axes Clicking on this button opens a menu giving the following choicesBothNoneDomain onlyRange onlyc. Colors Clicking on this button opens a menu giving the following choicesChart backgroundPlot backgroundd. Transparency Clicking on this button makes it possible to see points plottedbeneath other points, giving an idea of how often that point is visited.e. Transparency factor Clicking on this button opens a window in which it ispossible to change the transparency factor (which varies over (0,1) from the default(0.2) to increase transparency (smaller number) or decrease transparency (larger num-ber).f. Gridlines Clicking on this button produces gridlines on the plot.g. Big dots Clicking on this button magni¯es the dots on the plot. This option isuseful especially when studying trajectories and orbits of discrete-time systems.h. Connect dots Clicking on this button produces a plot in which the pointsplotted are connected, again useful in studying discrete-time systems.i. Crosshair Clicking on this button connects a crosshair to the mouse. Thecoordinates of the crosshair are visible to the left of the plot.



5j. Not listed is a zoom option which is activated by selecting with the mouse thedesired area of the plot that is to be magni¯ed. Notice that since the area is re-calculated, zooming requires as much time as the original plot.SamplesThe Sample button permits the user to save, and later recall, the constellation ofvalues used to produce the current plot. Sample constellations for intersting plots ofsome models and algorithms are already saved and can be seen by clicking on theSamples button. It is also possible to delete samples.a. Add sample Clicking on this button opens a window in which there appears adefault name for the sample (the values chosen). The name can be changed as desired.b. Remove sample Clicking on this button opens a window in which are displayedthe existing samples for a speci¯c model and speci¯c algorithm. Choose the samplesto be eliminated. 2. User input for algorithmsIn this section the main categories of user input for the various algorithms areexplained. All ¯elds must be completed before the Start button actually initi-ates the chosen routine. For further explanation and a short example of a ses-sion download the ¯le getting started from the Documentation part of the websitewww.dss.uniud.it/nonlinear.Initial values Variables of the model appear in the order they were given in themodel de¯nition, see Model text in the Model window. By assigning intial values theuser tells the algorithm at what point in the state space to begin the trajectory. Arandom choice is not a good choice for the starting point. The user should be eitherfairly familiar with the system's dynamics or have some guidance (see, for example,Nonlinear dynamics: computer exercises, a computer exercise workbook making useof iDMC and available at www.dss.uniud.it/nonlinear).Parameters Again, parameters appear in the order in which they were given in themodel de¯nition. The choice of values is again a delicate matter and the user shouldhave a good idea of range of values that lead to stable asymptotic limit sets, otherwisethe trajectory will quickly take on very large values.Algorithm The input ¯elds required depend also on the type of plot chosen. Otherspeci¯c terms will be discussed as they appear in particular routines.a. transients The user provides the number of iterations, starting from the des-



6ignated initial values, that will not be represented in the graph. If the user wants theentire trajectory plotted the input value is 0. If the user is interested in asymptoticbehavior a nonzero input value for transients will be necessary. At just what pointthe behavior can be considered \asymptotic" is a delicate issue, the choice dependson the model and the objective of the simulation.b. iterations The user provides the number of iterations for the trajectory, beyondthe designated number of transients. For example, if the user assigns transients1000 and iterations 1500, the algorithm calculates 2500 iterations and plots fromiteration 1001 through 2500.Auto ranges iterations The user provides the number of iterations to be usedas the basis for calculating the domain and range of the plot. Following the exam-ple in b. above, if the user assigns iterations 2500 the entire calculation will beperformed, the axes calculated and then the points plotted. If, instead, a smallernumber is assigned, such as iterations 500, the axes are calculated and appear after500 iterations. In this case another 500 transients are calculated, but do not appear.The ¯nal 1500 points are plotted as they are calculated.Axes The user can decide which variables to plot and on which axes.3. Absorbing areaThis routine allows the user to plot the absorbing area of an iterated map usingthe method of crtical lines (see, for example, Abraham, Gardini and Mira, Chaos inDiscrete Dynamical Systems, New York: Springer-Verlag, 1997). There are a numberof steps, which should be followed in the order given below. The input ¯elds will beexplained in the step descriptions. Notice that the Jacobian matrix must be providedin the model ¯le and currently the maximum is 2 diimensions.a. Plot critical set Pressing this button causes the algorithm to calculateand plot the points for which the determinant of the Jacobian matrix is zero, withprecision as indicated by epsilon.b. Plot attractor Pressing this button starts the attractor algorithm whichworks in the following way. Click on a point of the plot displayed. The algorithmuses the information provided in the ¯elds to plot the attractor initiating a trajectoryfrom that chosen point. To be sure that only the attractor appears, give a su±cientnumber of transients to be ignored. For a denser plot of the attractor use a highernumber of iterations. Not all points on the plot necessarily converge to the attractorand there may be more than one attractor, so that clicking several points is probablyuseful. Once the plotted attractor is satisfactory, press the Stop button to get out of



7the attractor plotting mode.c. Choose segments The critical lines method iterates segments which are inter-sections of the critical sets and the attractor. If steps a. and b. have been followedthe intersections should be clearly visible on the screen. Press the Choose segmentsbutton. Each segment is selected, one segment per dimension, by using 3 clicks of themouse. First, click near the critical set. Next, click near the left end of the intersec-tion of the set and the attractor. Finally, click near the right end of the intersectionof the set and the attractor. If \holes" are present in the chosen segments the ap-proximation of the trapping region will be less acurate (the region will be larger thannecessary, but anyway contain the attractor). Press the Stop button to get out ofsegment selection mode.d. Clear Having selected the segments to be iterated, press the clear button. Theattractor can be plotted again later, and there is also a button Hide attractor thatcan be used to produce di®erent ¯gures.e. Iterate chosen segments Currently the iteration is accomplished by press-ing the button, each time it is pressed another iterate of the segment is plotted, withthe given precision. The user can again press Plot attractor to see the attractorenclosed in the absorbing area. The Hide attractor button permits the user to re-move the attractor from the ¯gure, the Plot attractor button permits the user toredraw the attractor. 4. Basin of attractionThis routine allows the user to represent the basins of attraction for attractinglimit sets over a user-speci¯ed region of the state space. In the current version thisroutine is available only for maps, that is, systems of di®erence equations. Go to theFile menu and select from New plot the Basin of attraction routine.a. Basin of infinity This is the default algorithm which gives a relatively quickidea of the basin of attraction if there is only one attractor. Basically the screen isdivided into a grid of initial points which are iterated until they reach the valueassigned as in¯nity or converge to the unique attractor. In this case, points are eitherpart of the basin of in¯nity or part of the basin of the attractor. The input ¯elds aredescribed in c. below.b. All basins If there are multiple basins this algorithm should be chosen byclicking on All basins from the Plot menu.c. Algorithm attractor The algorithms ¯rst iterate a number (designated inthe trials ¯eld) of random initial points and as these trajectories converge to thevarious attractors, draw points in the limit set on the screen. In order to get all of



8the attractors set the number of initial values fairly high, say 100.The other two input ¯elds improve the appearance and accuracy of the representa-tion. In this routine the number assigned to the transients input ¯eld is the numberof times the algorithm iterates each point on the screen not yet colored as attractors,before checking where the trajectory is. After that number of transients the alorithmchecks if the trajectory has hit some part of an attactor appearing on the screen. Ifthis is true, all of the points on the trajectory from the initial grid point through thetransients are marked with the appropriate color.The user can decide to change the rectangle de¯ned in the Ranges input ¯eld, butthe rectangle must include a part of the attractor, otherwise the algorithm ¯nds novisible attractor (and nothing to which points can converge, leaving a black screen).De¯ning a rectangle which contains only a part of the attractor (without changing theattractor inputs) will likely lead to: thinner basins and possibly to the disappearanceof some basins if their attractors are not in the selected rectangle; thinner attractors.Thin attractors may be fattened up by increasing the number of points in thetrajectory, that is, the number of iterations. Thin basins may be fattened byincreasing the number of transients for two possible reasons. If trajectories are slowto converge and the number of transients is low, increasing the number should allowmore points of the basin to be plotted. If only a part of the attractor is visibletrajectories may be attracted to the part not displayed but if enough transients areallowed (and the attractor is su±ciently \ergodic") the trajectory should eventuallyreach the visible part of the attractor.5. BifurcationThis routine represents the limit sets of a dynamical system as one or two param-eters are varied. In the current version the algorithm is available for maps and arudimentary version is available for 3-dimensional di®erential systems. An improvedroutine for di®erential systems should be available in the next version. The case fordiscrete-time systems is straight-forward and given below. Di®erences in applyingthe routine to systems of di®erential equations are discussed subsequently. Go to theFile menu and select from New plot the Bifurcation routine. In the Plot menuthe Fixed initial point option should be ignored.a. Single parameter The default setting it to plot the asymptotic behavior ofthe system as a single parameter value is varied over a de¯ned range of values. Underthe Parameters section the user must select: the parameter to be varied (if there ismore than one); the minimum and maximum values to be used for that parameter(min and max respectively). The Vertical range refers to the axis values for thelimit sets of the variable which will be plotted on the ordinate axis.In the Algorithm section the user must carefully choose the number of transientsto be excluded and the number of iterations to be included in the calculation. In



9order to be assured that the trajectory has reached the attractor a su±ciently largenumber of transients must be excluded, otherwise the plot will contain points thatare not really part of the limit set. Further, to avoid misleading plots, the numberof iterations should be su±ciently large so as to cover the entire limit set. On theother hand, the total number of transients and iterations is positively related to thetime necessary to obtain the plot. The usual trade-o® between speed and precisionapplies. The user must also select which variable to represent on the ordinate axis (ifthere is more than one).b. Double parameter From the list of parameters two must be selected and themin and max values chosen for each. This algorithm requires input values for thenecessary Approximation parameters precision and in¯nity. Epsilon is an indicationat how ¯ne-grained the user wants the plot to be. The smaller epsilon, the closera value must be to the point to be de¯ned as that point. For example, settingepsilon= 10e ¡ 10 means that all points within approximately 0.0005 radius of apoint is taken as that point (and 10e ¡ 5 ¼ 0:0674). The infinity ¯eld de¯nes acut-o® value for unstable orbits. The value assigned to infinity tells the algorithmat what variable value the trajectory can be considered on its way to in¯nity. Verylarge values will do, but in many cases even relatively small values can be used, unlessthere are othere attractors existing far from those under consideration. Changes in thevalues assigned to these approximation parameters have little e®ect on the calculationspeed.It is the choice of transients that does e®ect the speed but, again, to avoidplotting the limit set and transients approaching it, the value of transients must besu±ciently high. Finally, the plot represents periodic limit sets and the user must ¯xthe highest number of periods (up to 35) to be considered for a given simulation. Itwill be tempting to take all higher-order cycles as quasiperiodic, but that is not thecase.c. Bifurcation for di®erential systems in 3-d. The bifurcation for continuous sys-tems routine that is currently available works in two steps. First it uses the Poincar¶eor ¯rst-return map to obtain a sequence of points in the plane (see Section 4.4). Fromthis set of discrete points the algorithm calculates the bifurcation map. The Plot op-tions are again Single parameter, Double parameter, Fixed initial point andthe Step function used in the integration routine.The Inital values, Parameters and Vertical range ¯elds are the same as dis-cussed previously. In the Poincar¶e section plane coefficients¯eld the user mustsupply the coe±cients of the equation that de¯nes the cutting plane. If the dimensionis 3 then 4 values are entered. For example if the user enters 1 2 3 4 the resultingplane is 1x+ 2y + 3z = 4.The Algorithm ¯elds must be given some attention. The input ¯eld Transientregards the sequence of points de¯ned by trajectory intersections with the Poincar¶e



10section (which are not situated at regular time intervals). The user supplies thenumber of initial (transient) intersections to be ignored. The Time ¯eld speci¯esthe number of time periods the trajectory and its intersections are observed. TheStep ¯eld is the usual step size for the ODE solution approximation and should beset su±ciently small in order to assure that the intersections with the section areaccurately observed. 6. CyclesThis algorithm calculates all k-cycles of a map for a given period and all values ofthe k periodic points. The algorithm uses an iterative Newton method to solve thesystem Gk(x) = (x). Once a periodic point is found the others are determined byiteration.Go to the File menu and select from New plot the Cycles routine. The algorithmis especially sensitive to the user input required to calculate the periodic points. Forexample, if 2 periodic points are very close and the precision parameter epsilon isfairly large, the period-k cycle may not be distinguished because, for that precision,the cycle has a period of k ¡ 1. The algorithm starts from a random initial point.If the trajectory from that initial value does not converge to a point on the cyclethe program randomly chooses the next initial point and so on up to the maximumnumber of attempts speci¯ed in the max.tries ¯eld. In order to get all cycles thisvalue should be ¯xed large, depending also on the precision chosen, but even setting10000 will not reduce the speed too much.In this version the points are plotted without reference to stability or to whichparticular cycle the periodic points belong. This should be available in the nextversion. 7. Lyapunov exponentsa. Parameter This is the default routine. The user selects which parameter tovary and gives the min and max values to be considered. The Vertical range refersto the values of the Lyapunov exponents, which typically have fairly large negativeexponents and small positive exponents. However most interest centers around zeroand positive exponents for which a very small ranges can be used. The Lyapunovexponent is a time-averaged value and su±cient iterations should be speci¯ed. If indoubt as to the iterations required for convergence use the Time plot over a numberof paramter values.b. Time Clear the current plot and select the Time option from the Plot routine.Click on Crosshair from the Option menu to see the zero line better and estimatevalues (crosshair coordinates appear on the left).c. Parameter space This option considers a sub-region of parameter space and



11uses a color coding to resperesent the number of positive, negative and zero exponents.The user must supply inputs for the Algorithm. The epsilon ¯eld refers to theLyapunov exponent. This value gives the symmetric range around zero that is usedby the algorithm to de¯ne positive, negative and zero and should be chosen carefully.If the point is to distinguish a negative value and zero an epsilon such as 0.001 mightbe appropriate. It the user wants to make sure that a positive value is de¯nitelypositive a less precise value should be speci¯ed.8. ManifoldsThe manifold routines are available only for maps, that is, systems of di®erenceequations, for which the manifold of interest is a curve in the plane (see, for example,Nusse and Yorke, Dynamics: Numerical Explorations, New York: Springer, 1998). Inthe current version only manifolds of ¯xed points are calculated and in some casesthe repositioning of the points lying in the lockout region seems to be malfunctioning.Go to the File menu and select from New plot the Manifolds routine.a. Unstable Stable Both From the Plot menu the user selects the manifold(s) tobe calculated. The default option is Unstable.b. Right Left Both From the Plot menu the user selects the branch(es) of theindicated manifolds to be calculated. The default option is Right. Note that theright and left branches may actually be the same.c. Node approximation The user supplies the approximate position of the ¯xedpoint. If the values are close to the ¯xed point the algorithm will ¯nd it.d. Algorithm input ¯elds. epsilon speci¯es how long is the segment starting closeto the ¯xed point. A long segment will extend over more of the manifold at eachiterate, consequently, there will be fewer estimated points on the curve. The numberof iterates of the given segment is speci¯ed in iterations.e. Lockout region ranges In the calculation of the manifolds the points on thecurve may take on very large values. While the Plot ranges de¯nes the screen plot,the lockout ranges de¯ne the region in which the calculation occurs. This avoids theproblem of over°ow errors due to excessively large numbers. Again, in the currentversion, the repositioning function for points lying in the lockout region may not beworking. 9. Shifted and cobwebThese two routines are available only for one-dimensional maps, that is, a singledi®erence equation. Go to the File menu and select from New plot the Shifted &Cobweb routine.



12a. Shifted The default is the Shifted plot which permits the user to plot thevalues of the variable, shifted forward k periods, on the ordinate axis against thecurrent values on the abscissa. That is, the kth iterate of the map is represented inthe (xn; xn+k) plane. The user provides k in the Algorithm ¯eld labelled order.b. Cobweb animation From the Plot menu select Cobweb animation. This rou-tine draws the kth iterate of the map in the (xn; xn+k) plane as in the Shifted plot.It also draws the bisector and the forward trajectory using the bisector to re°ect backto the abscissa at each pass in order to determine the next iterate value from thecurve. The user supplies the Initial value and should avoid critical values for themap. The user chooses to view transient behavior by assigning 0 to transients orchooses to view asymptotic behavior by assigning transients a high value. The mo-tion is slowed down and the speed can be adjusting by dragging on the arrow abovethe plot. Use the Stop button to stop the trajectory plotting.10. TrajectoryThis set of routines form an e±cient and °exible way of viewing trajectories andorbits. Go to the File menu and select from New plot the Trajectory routine.Notice that in the Options menu for discrete-time models the Trajectory plots canbe drawn with Big dots and/or Connect dots to render the results visible to theuser. The following description is based on a model represented by a system ofdi®erence equations, that is, equation(s) in discrete time. Additional informationfor systems of di®erential equations, that is, equations in continuous time, is givensubsequently.Plot There are options for viewing the trajectory.a. State space This is the default choice for systems of more than one variable.The user must simply provide values and then click on Start. Other options available:zoom, Big dots and Connect dots (click redraw).b. Time plot The plot represents the time evolution of the variable chosen for theRange axis. This is the default plot for one-dimensional maps. To change to Timeplot click Reset ¯rst.c. Variation Multiple trajectories can be displayed in a single plot by using thisoption. The user can increase or decrease the value of a parameter or initial conditionby specifying the amount to change at each variation in the second column of input¯elds that appears when the Variation routine is clicked on. Place a 0 in the second¯eld for all parameters or initial conditions that do not change. For example, supposea parameter parameter b is set at 0.2 in the ¯rst ¯eld and 0.1 is indicated in thesecond ¯eld, while all the other second input ¯elds have zeroes. In the Algorithm



13part the user must indicate how many simulations should be done. Suppose the userhas set this value to 10. The Variation routine then produces a plot for which, ateach subsequent simulation (after the ¯rst), the value of the parameter b is increasedby 0.1. The ¯rst trajectory is calculated with b = 0:2, the second trajectory withb = 0:3, and so on.This option is useful for viewing how limit sets change as a parameter changes, orhow sensitive the dynamics are to initial conditions. Simulations are color-coded andthe number next to each color de¯nes which simulation is represented by that color.d. Automatic bounds The default for these plots is that the axes ranges arecalculated by the algorithm according to the choice made by the user in Auto ranges(see Section 2).e. Manual bounds This option allows the user to de¯ne the ranges of the axes (insome cases one axis may be determined). This is particularly useful for the Variationroutine.Continuous-time systems Di®erential equations must be integrated rather thansimply iterated. The default integrator in iDMC is a Runge{Kutta procedure (rk8pd,see description and list of alternatives in appendix 1) which uses the ¯xed step sizeprovided by the user. To change the integrator click on Plot and click on the newchoice from the Step function options.The accuracy of the integration is inversely related to the size of the ¯xed step.The choice of step size depends on the model and on the purpose of the simulation.Setting the step too large may result in such erroneous representations of the curvethat the dynamics are not even qualitatively the same. Setting the step very smallwill, however, increase the time necessary for calculation.For systems in continuous time the number of iterations and the number of periodsare related but not equal. For example, a step size of 0.02 means that the interval be-tween time t and time t+1 is divided into 50 equal intervals. The number of iteratesmultiplied by the step size gives the number of time periods. Using 1000 iterationswith a step size of 0.02 means 20 time periods have been simulated. Trajectories andorbits are made smoother by ¯xing smaller steps but the number of iterations mustbe adjusted accordingly to cover the same time period.11. Model referencesThe model directory is composed of well-known prototypical models plus: a direc-tory with models used in computer and analytical exercises (see below) and a direc-tory with a collection of economic models (see below). A reference for each model isgiven where information on the model, including further bibliographical references,are provided.



14 Cremona. See Alberich-Carramiana, 2002.Gingerman. See Phaser software.H¶enon. See Medio and Lines, 2001, chapter 7.Ikeda. See Alligood, Sauer and Yorke, 1996.Logistic. See Medio and Lines, 2001, chapter 8.Lorenz. See Medio and Lines, 2001, chapter 6.Lv. See Medio and Lines, 2001, chapter 4.MSmith. See Maynard Smith, 1986.Nordmark. See Nusse and Yorke, 1998.Quasi2. See Nusse and Yorke, 1998.Rossler. See Medio and Lines, 2001, chapter 7.Rotor. See Nusse and Yorke, 1998.Silnikov. See Medio, 1992, chapter 4.Sine circle map. See Medio and Lines, 2001, chapter 8.Standard. See Alligood, Sauer and Yorke, 1996.Tent. See Medio and Lines, 2001, chapter 6 and Elaydi, 2000.Tinkerbell. See Alliggod, Sauer and Yorke, 1996.Vanderpol. See Medio and Lines, 2001, chapter 8.Primer models These models are used in connection with the book Nonlinear dy-namics: a primer (Medio and Lines, 2001) and the accompanying computer exerciseworkbook Nonlinear dynamics: computer exercises available at the software websitewww.dss.uniud.it/nonlinear.Con2d. See Medio and Lines, 2001, chapter 2.Cona. Model created by Gianluca Gazzola as exercise.Conb. Model created by Gianluca Gazzola as exercise.Conlyapa. See Medio and Lines, 2001, ex. 3.11 (b).Conlyapb. See Medio and Lines, 2001, ex. 3.11 (d).Conbif. See Medio and Lines, 2001, ex. 5.6.Conlocal. See Medio and Lines, 2001, ex. 3.11 (a).Conpar. See Medio and Lines, 2001, chapter 1.Disa. Model created by Gianluca Gazzola as exercise.Disbif. See Medio and Lines, 2001, ex. 5.8 (c).Dispar. See Medio and Lines, 2001, chapter 1.Disparlag. See Medio and Lines, 2001, chapter 2.Flip. See Medio and Lines, 2001, ex. 5.8 (a).Hopf. See Medio and Lines, 2001, ex. 5.7.Quasi. See Medio and Lines, 2001, chapter 4.Vanderpol. See Medio and Lines, 2001, chapter 8.



15Economic models These are models used in teaching with the book AdvancedMacroeconomics (Romer, 2001) and the accompanying computer exercises Macroe-conomic models: computer exercises available at www.dss.uniud.it/nonlinear.BH. See Brock and Hommes, 1989.Cournot. See Puu, 2003.Cournotad. See Puu, 2003.Diamond. An overlapping generations model with logaritmic utility and Cobb-Douglas production. See Romer, 2002 chapter 2.Olg1. See Medio, 1992, chapter 12.Olgns. See Medio and Lines, 2001, ex. 5.11 and Medio, 1992, chapter 12.Ramsey. A macroeconomic model with logaritmic utility, Cobb-Douglas produc-tion and technology. See Romer, 2002 chapter 2.Solow. The Solow growth model in per-capita terms. See Romer, 2002 chapter 1.Alberich-Carrami~nana, M. 2002. Geometry of the plane Cremona maps, Berlin:Springer-Verlag.Alligood, K. T., Sauer, T. D. and Yorke, J. A. 1996. Chaos: and introduction todynamical systems. New York: Springer-VerlagBrock W. and Hommes,C. 1989. Heterogeneous beliefs and routes to chaos in a simpleasset pricing model Journal of Economic Dynamics and Control 22, 1235-1274.Elaydi S. N. 2000. Discrete chaos, Boca Raton, FL: Chapman & Hall/CRC Press.Maynard Smith, J. Evolution, games and learning Physica D 22, 43-49.Medio, A. 1992. Chaotic dynamics. Theory and applications to economics. Cam-bridge: Cambridge University Press.Medio A. and Lines M. 2001. Nonlinear dynamics: a primer. Cambridge: CambridgeUniversity Press.Nusse H. E. and Yorke J. A. 1998. Dynamics: numerical explorations. New York:Springer-VerlagPhaser software, see site at www.phaser.comPuu, T. Attractors, Bifurcations, & Chaos - Nonlinear Phenomena in Economics,Berlin: Springer-Verlag, 2003.Romer D. 2001. Advanced Macroeconomics. New York: McGraw-Hill.



16 12. New modelsNew models can be introduced without having to re-compile iDMC because theyare written and read by the powerful Lua programming language (see below and thesite www.lua.org). The easiest method is to use an editor to call up an existing model,make the necessary changes and save the new ¯le, for example, mymodel.lua, in thedirectory Models. The basic structure for the model ¯le can be seen in the logisticmodel example below:name = \Logistic"description = \See Model Info"type = \D"parameters = \mu"variables = \x"function f(mu, x)y = mu*x*(1 - x)return yendfunction Jf(mu, x)return mu - 2 * mu * xendFor continuous-time systems change type to \C". Typical mistakes are forgettingto put the parameters and variables always in the same order when de¯ning functionsand not making proper use of quotation marks.The Lua language (Copyright, 2003 Tecgraf, PUC-Rio) is \a powerful, light-weightprogramming language designed for extending applications". This description andthe following excerpts are from the Lua 5.0 Reference Manual, Roberto Ierusalim-schy, Luiz Henrique de Figueiredo and Waldemar Celes, Tecgraf Computer ScienceDepartment PUC-Rio, 2003 (downloadable from www.lua.org). That document de-scribes version 5.0 of the Lua programming language and the Application ProgramInterface that allows interaction between Lua programs and their host C programs.For our purposes only the following characteristics of the language are central.Page 3. Numerical constants may be written with an optional decimal part and anoptional decimal exponent. Examples of valid numerical constants are3 3.0 3.1416 314.16e-2 0.31416E1Pages 8-10. Lua supports the usual arithmetic operators: the binary + (addition),- (subtraction), * (multiplication), / (division), and ^ (exponentiation); and unary -(negation).The relational operators in Lua are== ~= < > <= >=



17These operators always result in false or true. Equality (==) ¯rst compares thetype of its operands. If the types are di®erent, then the result is false. Otherwise,the values of the operands are compared. Numbers and strings are compared in theusual way. The operator = is exactly the negation of equality (==). The orderoperators work as follows. If both arguments are numbers, then they are comparedas such. Otherwise, if both arguments are strings, then their values are comparedaccording to the current locale.The logical operators in Lua areand or notAll logical operators consider both false and nil as false and anything else as true.The operator not always return false or true. The conjunction operator and returnsits ¯rst argument if this value is false or nil; otherwise, and returns its secondargument. The disjunction operator or returns its ¯rst argument if this value isdi®erent from nil and false; otherwise, or returns its second argument. Both andand or use short-cut evaluation, that is, the second operand is evaluated only ifnecessary.Operator precedence in Lua follows, from lower to higher priority:orand< > <= >= ~= ==..+ -* /not - (unary)Ŷou can use parentheses to change the precedences in an expression. The exponen-tiation operator is right associative. All other binary operators are left associative.Page 50. The library is an interface to most of the functions of the standard C mathlibrary. (Some have slightly di®erent names.) It provides all its functions inside thetable math. In addition, it registers the global pow for the binary exponentiationoperator ^ so that x^y returns xy. The library provides the following functions:math.abs math.acos math.asin math.atan math.atan2math.ceil math.cos math.deg math.exp math.floormath.log math.log10 math.max math.min math.modmath.pow math.rad math.sin math.sqrt math.tanmath.frexp math.ldexp math.random math.randomseedmath.pi.Most of them are only interfaces to the corresponding functions in the C library. Alltrigonometric functions work in radians (previous versions of Lua used degrees). Thefunctions math.deg and math.rad convert between radians and degrees. The function



18math.max returns the maximum value of its numeric arguments. Similarly, math.mincomputes the minimum. Both can be used with 1, 2, or more arguments. The func-tions math.random and math.randomseed are interfaces to the simple random gener-ator functions rand and srand that are provided by ANSI C. (No guarantees can begiven for their statistical properties.) When called without arguments, math.randomreturns a pseudo-random real number in the range [0, 1). When called with a numbern, math.random returns a pseudorandom integer in the range [1, n]. When called withtwo arguments, l and u, math.random returns a pseudo-random integer in the range[l, u]. The math.randomseed function sets a seed for the pseudo-random generator:Equal seeds produce equal sequences of numbers.For the following formats refer to the indicated model ¯le which uses that format:if then, see cournot.lua; math.mod, see sinecircle.lua; for inserting many constantsand the use of intermediate variables, see quasi2.lua.


